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About this guide

About this guide

This guide contains a detailed description of the features and functionality of the Infor LN Report
Designer. The guide also contains a brief overview of the structure of 4GL reports.

Intended audience

This guide is intended for professionals who work on LN implementations, and have specific knowledge
of the business functionality and requirements for reporting. In-depth technical knowledge of 4GL
reports is not required.

Related documents

You can find the documents in the product documentation section of the Infor Support Portal, as
described in "Contacting Infor".

» Infor LN Studio Application Development Guide
* Infor ES Programmer's Guide (Infor Support Portal KB 22924522)
* Infor LN Extensions Development Guide

Contacting Infor

If you have questions about Infor products, go to Infor Concierge at https://concierge.infor.com/ and
create a support incident.

The latest documentation is available from docs.infor.com or from the Infor Support Portal. To access
documentation on the Infor Support Portal, select Search > Browse Documentation. We recommend
that you check this portal periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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Introduction

Chapter 1: Introduction

The main purpose of the Report Designer is to enable changes to the design of a 4GL application
report, without modifying the standard report or using an external reporting solution. The changes are
stored as personalizations. Therefore, the effort that is required to implement changes after the standard
is updated is reduced.

You can also generate new reports that are based on a selection of fields from the application data
model. These reports are generated in the extensibility package. You can personalize these reports
in the Report Designer, or modify them in LN Studio.

Supported LN versions

The Report Designer is available with LN 10.5 and later. Enterprise Server 10.6 is required. The
Report Designer is only supported in LN Ul.

Note: On LN 10.5 you must re-compile the reports once with Enterprise Server 10.6 to enable them
for the Report Designer.

Devices
The report personalizations are only fully supported for devices that print from LN to PDF:

» Devices of the Display type, if you use LN Ul
» Devices with the Intermediate File in XML Format option enabled, that use the "XML -PDF"
argument

» Devices of the Document Output Management type, for report rules without report server

To print a report to this device type, the report must have a corresponding report rule defined in
the Report Rules (ttrpi2520m000) session. The report personalization is only used if no report
server is specified in the report rule.

For details about Document Output Management (DOM), see the Infor LN Document Output
Management User Guide.

For options to copy the file from the LN server or to send it to a printer, see the Infor LN Transfer
Service Administration Guide.

Other devices do read the personalization, but may not give the expected result.
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Introduction

Reports

Reports are used in sessions to show data on the screen, or print data on a printer or another output
device. A session can have multiple reports. On a report, data such as fields and labels are available.
The position of the fields is defined in report layouts.

Report personalization

The combination of changes to the report made in the Report Designer is stored as a personalization.
You can find these changes in the Report Personalizations (ttadv9507m000) session. As with other
personalizations, you can copy them to the role and company levels. When you print a report, the most
specific personalization is used.

The personalization does not replace the standard report. Only the changed or added layouts are
stored in the personalization. The standard report is still executed, and its logic. Layouts that are present
in the personalization are not executed by the standard.

Report input fields

The report input fields are the fields defined by the application as available for use on the report layouts,
along with domain information. Domain information includes information about the data type and default
formatting of the fields. The fields can be table fields, or calculated fields, which are determined by the
print logic in the application.

You can define a sort mode on input fields.

This table shows the sort modes you can select:

Sort mode Description

Ascending The report sorts the printed records in ascending order.

Descending The report sorts the printed records in descending order.

Presorted The application is responsible for the order of the records that are printed. The

report does not sort the records.

If no sort order is defined for an input field, the original order of the records is preserved. In that case,
you cannot link Before Field or After Field layouts to the input field.

Additional input fields are customer defined fields, and fields that are added by the report extension.
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Report layouts

A report layout contains the labels, fields, and lines in the desired position. Several types of layout are
available. These layouts, along with the output condition, control when their contents are printed. If
multiple layouts of the same type are printed, then their sequence number determines their output
order. Thus, if both Header 10 and Header 20 are to be printed, Header 10 is displayed first on the
page.

This table shows the available layout types:

Layout type Description

Before report This layout is printed once at the start of the report. You can use this layout to,
for example, print a title page or information about the report.

Header This layout is printed at the start of each page.

Before Field This layout is linked to a sorted input field. It is printed whenever the value of

that field changes, and at the top of each page. You can use this layout to group
data and print details of that group. For example, a report prints Employees by
Department. This report could use a Before Field Department group to print the
department details once, and then print a list of employees.

A change in a sorted input field with a lower sequence number implies a change
in the sorted input fields with higher sequence numbers. Therefore, the layouts
with higher sequence numbers are also printed. For example, the sorted input
fields are Sales Order and Sales Order Line, in that sequence. A Before Field
Sales Order Line layout is printed when the sales order changes, even if the
line number did not change.

Detall This layout is printed every time the application sends data to the report.

After Field Similar to Before Field layouts, this layout is linked to a sorted input field. It is
printed when the value of that field changes, but after the entire group. You can
use this layout to show group totals.

Footer This layout is printed at the bottom of each page.

After Report This layout is printed once at the end of the report. If this layout does not fill the
complete page, footer layouts are also printed on this page.

When a report is printed in a right-to-left language, the report layouts are automatically mirrored
horizontally. Therefore, you can use a single report definition for both left-to-right and right-to-left
printouts. When the Report Designer receives such a right-to-left print, it mirrors the original layouts.
The user interface of the Report Designer itself is mirrored independently of the report. If the browser
is set to a right-to-left language, the user interface of the Report Designer is mirrored.
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Report script

Some behavior of a report cannot be modeled with the available properties on layouts or fields. Instead,
a report can have a script attached, which contains sections that are called when specific layouts are
printed. In the Report Designer, you cannot modify or add a script. If a personalization is present, then
the standard report script is still executed when appropriate. The standard report script can, for example,
perform these actions:

» Calculate values
»  Skip to a specific line on the page for a layout
* Repeat a layout multiple times
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Chapter 2: Personalizing reports

You can use the Report Designer to make changes to the design of a 4GL application report, without
modifying the standard report or using an external reporting solution. The changes are stored as
personalizations.

Opening a report to personalize

Because of the close relationship between input data and the result, the Report Designer uses a
printed report as input. The Report Designer starts only if the report is printed to PDF through a device
of type Display. In the WebUI Print Settings (ttaad3108m000) session, you can configure the preview
device to print to PDF.

1 Start a session and click the gears icon to open the settings menu.

2 Onthe settings menu, select Personalize Reports. This message is displayed: Print a report
to start personalizing

Note: The Personalize Report command is available in all sessions.

3 Inthe message window, click OK.
4  Print the report which you want to personalize as a PDF, through a device of type Display. The

Report Designer starts. You can print the first report through the session that you started in step
1 or through another print session. In both situations, the Report Designer starts.

Some processes print multiple reports at once. All these reports are displayed in the same Report
Designer instance. Any reports that are printed while the Report Designer is open are also displayed
in that instance. After the Report Designer is closed, you must run the Personalize Reports command
again before you can start a new Report Designer instance.

The central area of the Report Designer initially shows the design of the layouts that have been printed.
At this point the fields reflect the actual data on the report. Multiple side panels are available.

See Report Designer side panels on page 10.

Report Designer side panels

This table shows the side panels that are available in the Report Designer:
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Side panel Description

Layouts Contains a dropdown with the list of reports that were printed, and lists all layouts
in the selected report. Below the dropdown, the current level of the printed per-
sonalization is displayed. The personalization can be on user, role, or company
level. The personalization is always saved on user level.

Input Fields Lists all report input fields. Table fields are grouped together. Non-table fields
are grouped as Calculated fields.

Special Items Lists items that can be added to the report layouts, but which are not input fields.
For example, lines, images, and barcodes.

Properties A context-sensitive area that shows various properties that are applicable to the
currently selected item.

Problems Lists warnings and errors. You must resolve the errors before you can use the
report personalization for printing.

This panel is collapsed by default. To view the list, click the up arrow button in
the lower-right corner of the page, or drag the panel up.

Showing or hiding layouts

Initially the Report Designer shows only those layouts that were printed on the report for the selected
data.

Use the check boxes in the Layouts panel for these purposes:

* View and modify layouts that were not printed.

*  Show or hide specific layouts, or all layouts of a specific type.

Note: These check boxes do not affect the report personalization. It is only a utility within the Report
Designer, but does not affect which layouts are printed on the report. To influence the report, you can
use the Print Condition property on the layout.

On the Actions menu, these commands to toggle layout visibility in the editor are available:
« Show All
Makes all layouts of the report visible, regardless of whether they were printed.

* Show only personalized layouts
Hides all unmodified layouts. Shows all layouts that were modified and all new layouts.

Note: Personalized layouts are displayed with their names in italics, in both the Layouts panel and in
the editor. This does not apply to new layouts.
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Selecting a report, a layout, or fields

Initially the report is selected, and the Properties panel shows the report properties. To select the
report when something else is selected, click on the editor area, outside of a layout.

To select a layout, click on its name in the Layouts panel. Alternatively, click an empty area inside the
layout in the editor. To select multiple layouts, hold down Ctrl while you click the additional layout.

You can work with fields in these ways:

» To select a field, click it.

» To add a field to the current selection, hold down Ctrl while you click the additional field.

» To remove a field from the selection, hold down Ctrl while you click that field.

 When afield is selected, you can click inside a layout while you hold Shift. This expands the
selection to include all fields between the selected field and the cursor.

» To select all fields in a selected layout, click Select all in the Properties panel.

Previewing the current report personalization

To re-run the report with the same data as was printed originally, click Preview in the main toolbar. If
you made changes, then the new version of the personalization is used for the preview. If unsaved
changes are present, then you are prompted to save. You must save the personalization to make it
effective. If you preview the report without saving, the previous version is displayed.

Note: On certain reports the preview cannot give an identical result as the original printed report. We
recommend that you test the final personalization by printing from the session directly, instead of using
the preview option. The report may behave differently depending on the selected data. This is due to
print conditions or due to grouping, for example multiple orders with multiple lines. You can re-print the
same report from the session for a different selection. Then the Report Designer uses that data for
the preview option.

Handling problems after saving

When the personalization is saved, validation and processing is done before the personalization
becomes effective. Issues can arise during this process. These issues must be solved before you can
save the personalization properly.

Errors are displayed in the Problems panel. For each problem, the message, the report layout and
field, if any, are displayed. Double-click a problem to select that layout or field.

When the affected layout or field is modified, the icon of the problem becomes gray, to indicate that it
may no longer be relevant. After saving, the problem may disappear.

Sometimes the Problems panel does not show an issue, or does not give enough context. In these
cases, you can find more information by selecting Plain Output. If this check box is selected, the
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plain-text output of the report script generator (repgen) and the compiler (bic) is displayed. If there is
no output, for example because an error occurred before the generator was started, this check box is
not available.

Changing Report Designer settings

1 Click the gear icon in the main toolbar to open the Settings menu.
2 Change the desired settings.
See Report Designer settings on page 13.

3 Save the settings: on the Settings menu, select Save Layout.

Report Designer settings

You can use the Settings menu to change Report Designer settings. This table shows the options
on the Settings menu:

Option Description

Show Field Name Initially the Report Designer shows the field values as they were displayed on
the report. Select this option to show the field names (print expression) instead.
This is useful if, for example, several fields have the same content, or fields are
empty.

Show Field Data Select this option to switch back to the initial setting, so that field values are
displayed instead of field names.

Grid Size Use this sub-menu to change the size of the grid and text in the editor. This
does not affect the report. This can make text easier to read, or give a better
overview of the report layouts.

Show Rulers Use this option to toggle the visibility of the rulers in the editor. The rulers indicate
the size of the report layouts and the current position of the cursor.

Show Grid Use this option to toggle the grid visibility. This does not change the grid-based
editing behavior of the editor.

Show Grid During  Select this option to make the grid visible on the actual report when the preview
Preview option is used. This option can be useful to properly position and resize fields.

Unit Use this submenu to change the units that are displayed in the Report Designer.
This applies to the rulers, and the properties that are specified as a length.

Report Personal-  Starts the Report Personalization - History (ttadv9508m000) session.
ization History
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Option Description

Save Layout Select this option to save the settings.

The options on the Settings menu and the panel sizes are remembered as
part of the workbench settings. These are also saved when you click Save
changes and exit in the main toolbar.

Reset Layout Select this option to reset all options to their default setting.

About Starts a dialog box with version information.

Using exact positioning

For reports that are printed to PDF, positioning more precise than columns and lines is available in the
Report Designer.

You can convert the current personalization, if any, one time to use exact positioning. This action
calculates the correct position and size for each field, based on its current position and the grid size.
You cannot reverse the conversion after saving and closing the Report Designer: to return to the
situation before the conversion, you should reinstate an old version of the personalization, or remove
the personalization.

After conversion, the report personalization is ignored when printing to devices without intermediate
XML file.

Reports may contain layout logic that is defined by the application. For example, jumping to the bottom
of the page when a certain layout is printed. A report with exact positioning ignores this layout logic.
Instead, you should define this logic in the personalization.

Converting a report to use exact positioning

Select Actions > Convert to Exact Positioning on the main toolbar. The editor is updated with the
new report definition and a different set of properties is available.

Changing report properties
1 Select the report to view.

2 Edit the report’s properties in the Properties panel.
These properties are available:
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Columns

Specify the number of columns, in characters, that is available on the report. Specify a value
between 1 and 255. By default, the PDF converter switches to landscape pages at a width of 150
columns.

This property is not available if you use exact positioning.

Paper Size
Select one of the predefined paper sizes, or select Custom Size to manually specify the width
and height of the paper.

Width
The width of the paper to use for this document. You can only change this value if Custom Size
is selected for the paper size.

Height
The height of the paper to use for this document. You can only change this value if Custom Size
is selected for the paper size.

Left Margin
Specify the left margin, in cm.

Right Margin
Specify the right margin, in cm.

Top Margin
Specify the top margin, in cm.

Bottom Margin
Specify the bottom margin, in cm.

Footer Margin

Specify the number of lines that are reserved for the footer layouts on a page. If the value is -1,
this property is automatically determined by the reporting engine. If you have footer layouts of
differing heights and conditions, then you must specify this property, because the automatic
calculation does not work.

This property is not available if the report uses exact positioning. By default, footers are
automatically positioned at the bottom of the page.

See Fixed positions for layouts on page 18.

Page Length

Specify the number of lines to be printed on a page. If this value is -1, the number of lines per
page depends on the chosen device.

This property is not available if the report uses exact positioning.

Grid columns have fixed width

If a font size is specified for a field, it may be that the field content does not fit in the reserved area.
Normally the PDF converter then resizes columns to ensure that fields do not overlap and are
positioned in the correct relative order.

If this check box is selected, the converter does not resize columns, but only draws the text. This
makes the layout more predictable when the font size is changed, at the risk of overlapping fields.
This property is not available if the report uses exact positioning.
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Reset page number before layouts

Select the layouts for which the page number of the report should be reset. Whenever one of the
selected layouts is printed, the page number continues counting at 1. Only layouts for which the
New Page property is selected are available.

Font

Specify the font to use for the report. You can override this setting for specific fields. The list of
fonts is automatically initialized using the system fonts, but additional fonts can be added manually.
See the Fonts (ttaad3560m000) session.

Font Size
Specify the font size, in points, for the report. You can override this setting for specific fields.

Background Image
Specify the image to be displayed as background for each page of the report.

Preserve Ratio

If this check box is selected, the background image is resized to fit the page. The original aspect
ratio of the image is maintained.

If this check box is cleared, the image is stretched to fill the entire page.

Sheet Name

This property is relevant if you export the report to an Excel workbook.

Specify the name of the Excel workbook sheet to which the report must be exported. If you leave
this field blank, the sheet name is Data.

Note: The report margins, excluding the footer margin, lie outside of the grid. A larger left margin, with
all other properties equal, results in a narrower grid.

Changing existing layouts

Changing layout properties

1 Select a layout. The layout’s properties are displayed in the Properties panel.

2 Edit the layout’s properties in the Properties panel. The size of the layout can also be changed
by dragging the handles at its edges.

These properties are available:

Columns

Specify the width of the layout as a number of characters. This may influence the dynamic sizing
behavior of the PDF converter for some standard reports. To observe this behavior, select Show
grid during preview on the settings menu.

This property is not available if the report uses exact positioning.
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Lines / Height

If the report does not use exact positioning, the name of the property is Lines. Specify the height,
in lines, of the layout. This is the number of lines consumed on the page by the layout, regardless
of its content or the Extra lines property.

If the report uses exact positioning, the name of the property is Height. It has the same function
as Lines, but is specified as a length.

Extra lines / Extra Required Space

If the report does not use exact positioning, the name of the property is Extra lines. Before printing
a layout, the reporting engine determines the free space at the current page. If the layout does
not fit on the same page, the layout is printed on a new page. If the value of this option is 0, only
the height of the layout itself is taken into account. With this option you can increase the number
of extra free lines for the layout. You can use this property to ensure at least one detail line is
printed together with the group header.

If the report uses exact positioning, the name of the property is Extra Required Space. It has the
same function as Extra lines, but is specified as a length.

The Extra lines / Extra Required Space property is not available on Header and Footer layouts.
In the Development Tools and LN Studio this property is referred to as Extra Need.

Start on new page

If this check box is selected, the layout is printed on a new page. When a new page is started,
also Header, Footer, and Before Field layouts are printed. If the current line is at the top of the
page, this option has no effect.

If this property is set on a Before Field layout with a sequence number higher than another Before
Field layout, only the layout with higher sequence is printed on the new page. The other layout is
printed on the previous page and is not repeated on the new page. In this case, headers are
printed on the new page.

This property is not available on Header and Footer layouts.

Dataset

You can use this property to link the report layout to a dataset. The layout is not printed as part
of the normal flow, but only if the dataset is printed. This is controlled through the Datasets to
Print property.

If a layout is linked to a dataset, it can only contain data fields that are specified by the dataset.
This property is only available if the report extension contains a dataset definition. This property
is read-only if the report layout contains data fields.

Dataset Part
This property specifies at which time this dataset layout should be printed. Select one of these
values:

* Header

This layout is printed once at the start of the dataset, and at the start of a new page.
¢ Detail

This layout is printed for each record in the dataset.
¢ Footer

This layout is printed once after all records in the dataset have been printed.

This property is only available if a dataset is selected.
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Datasets to Print

Specify the datasets that should be printed whenever this layout is printed. A dataset is printed
only if it has any data.

This property is only available if the report extension contains a dataset definition, and the layout
is not a dataset layout.

Background Image
Specify the image to be displayed as background when this layout is printed.

Preserve Ratio

If this check box is selected, the background image is resized to fit the layout. The original aspect
ratio of the image is maintained.

If this check box is cleared, the image is stretched to fill the entire layout.

Standard print condition
This property is read-only. It shows the condition that must be true for the layout to be printed.
The expression is 3GL code.

Personalized print condition

Optionally, specify a condition to be used in addition to the standard condition.

You can use this property for these purposes:

e Suppress the layout in some situations. The layout is printed only if both the standard condition
and the personalized condition are true.

« Based on the value of report input fields, print a layout with a different style or a different
selection of fields.

« Completely suppress a layout. To achieve this, specify 0 or £alse in this property.

Sheet Break

This property is relevant if you export the report to an Excel workbook and is only applicable for
Before Field layouts.

If this check box is selected, an Excel workbook sheet break occurs each time the Before Field
Layout is printed.

Rows

This property is relevant if you export the report to an Excel workbook.

Specify the number of Excel rows that is required for the layout.

For ‘non-exact positioned’ reports, the default value for this property is automatically set to the
number of lines in the layout.

Note: For complex reports, the print condition alone does not guarantee that the report layout is printed
if the condition matches. The standard report might have a script with a complex programmed condition
that is invisible to the Report Designer.

Fixed positions for layouts

This option is only available if the report uses exact positioning. Except for footer layouts, layouts are
printed in sequence while they fit on the current page, exactly underneath the previous layout. Footers
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are stacked on top of each other. The total height of the combined footers determines the reserved
area.

You can change a layout to always print at a fixed position on the page. If the current page is beyond
the fixed position of a layout when the layout is printed, the layout is printed at the specified position
on the next page. If the layout is a footer layout, this does not happen: it is always printed at the specified
position on the current page. Multiple footer layouts can overlap each other.

Configuring fixed positions for layouts

1 Select a layout. A toolbar is displayed in the properties panel.
2 Inthe toolbar of the properties panel, click Layout Positions to open the dialog box.
3 For the selected layout, select one of these options:

No Fixed Position

This is the default option. The layout is printed on the position after the previous layout. For footer
layouts, this means the footer is printed above the next footer layout without fixed position, or at
the bottom of the page.

From Top
Specify a position. The layout is printed with the top of the layout at the specified position.

From Bottom
Specify a position. The layout is printed with the bottom line of the layout at the specified position.

Text filters

Some LN reports support the concept of external and internal text in multiline text fields:
* The external reports remove internal text, but do show external text.

» The internal reports remove external text, but do show internal text.

In the Report Designer, you can perform these actions:

* View the text filters that are defined in the standard report.
» Define text filters for fields that do not have a filter.

Configuring text filters

1 Select a text field in a layout. A toolbar is displayed in the properties panel.

2 Inthe toolbar of the properties panel, click Text Filters to open a dialog box that shows all input
fields that have data type Text.

3 For the appropriate fields, select one of these options:

No Filter
This option indicates that currently no text filtering is applied. All lines are printed as-is.
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Show external text

This option indicates that external text should be displayed:

«  For lines that start with *>’, the initial character is removed before printing.
e Lines that start with ‘<’ are not printed.

¢ Other lines are printed as-is.

Show internal text

This option indicates that internal text should be displayed:

< For lines that start with ‘<’, the initial character is removed before printing.
¢ Lines that start with *>" are not printed.

e Other lines are printed as-is.

Moving, copying, or deleting a field

To move a field or a group of fields, select the field or group and then drag it to a new position. You
cannot position fields on top of each other. You cannot move fields outside of their current layout,
because often there is an implicit data dependency. You can also move fields by using the keyboard.
Hold down Ctrl and use the arrow keys to move the selected fields. Press Shift at the same time to
move the fields faster.

To copy fields, click Copy in the main toolbar, or press Ctrl + C. You can copy fields within the current
layout and to another layout. You can copy fields to the clipboard by selecting Actions > Copy to
Clipboard. To paste these fields, select Actions > Paste from clipboard, or press Ctrl + V. Fields
that are copied to the clipboard can also be pasted on other reports.

To delete fields, click Delete in the main toolbar, or press the Delete key.

Adding a field

To add a new data field, drag the corresponding input field onto the target layout. The field uses the
formatting and alignment options of the domain that is linked to the report input field.

After adding the field, you can change the field properties in the same way as for existing fields.

The print expression is based on the report input field and its type. For array fields, the expression
refers to the first element.

Changing field properties

1 Select a field. The field's properties are displayed in the Properties panel.

When a single field is selected, the editor shows layout handles in the middle of each edge. You
can change the display size of the field through these handles and through the Properties panel.
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2 Edit the field’s properties in the Properties panel.
These properties are available:

Print expression
Specify the content to print in this field. You can specify a field name, or a more complex 3GL
expression.

Left
Specify the position of the field from the left side of the layout.
This property is only available if the report uses exact positioning.

Top
Specify the position of the field from the top of the layout.
This property is only available if the report uses exact positioning.

Width
Specify the reserved width of the field, in columns.
If the report uses exact positioning, this property is specified as a physical length.

Height
Specify the reserved height of the field.
If the report uses exact positioning, this property is specified as a physical length.

Domain

Specify the domain of the field. The domain specifies the data type and formatting defaults of the
print expression.

This property is read-only if the print expression is a report input field. In that case, the domain of
the field is used.

Show as Icon

If this check box is selected, an icon, instead of a description, is displayed for enumerate options.
These icons can be specified in the Enum Domain Formatting (ttgfd4525m000) session. If an
icon is missing, a default is used.

This option is available if the data type of the domain is Enumerated.

Linked with Domain
If this check box is selected, various formatting options are derived from the information on the
domain. If this check box is cleared, you can specify these options manually.

Data length
Specify the maximum number of characters for the field content. This property is only available if
the data type of the domain is String, Text, or Enumerated.

Display format

This property specifies the exact formatting of the field content. The format must be valid for either
the edits or the sprint£s 3GL function.

This property is not available if the data type of the domain is String, Text, or Enumerated.

Alignment

Specify the horizontal alignment of the field content within its reserved space.

If the report uses exact positioning, you can also specify vertical alignment.

This property is not available if the data type of the domain is Text, Date, or Date-Time (UTC date).
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Minimum lines
Specify the minimum number of lines to print for a text field.

Maximum lines
Specify the maximum number of lines to print for a text field.
If this value is 0, the entire text is printed.

Line spacing

Specify the line-spacing as a factor of the font size.

This property is only available if the report uses exact positioning.

In a report that uses exact positioning, you cannot directly change the height of a text field. Instead,
the visual height in the Report Designer is determined by the Minimum lines property. The height
of a single line is determined by the Line spacing and Font Size properties.

Language Expression

Specify the language in which to print the field content, or for which language the date format
should be retrieved.

This property is available only if the data type of the domain is Date, Date-Time (UTC date), Text,
or Enumerated.

Currency Expression
Specify the currency for which to retrieve the generic formatting.
This property is available only if the data type of the domain is Float or Double.

Aggregation Function

If set, the print expression is aggregated using the selected function, and the aggregated value is
printed instead.

Depending on the layout type in which the field is present, different records are aggregated. For
an aggregated field in a Footer layout, the records that are printed on that page are aggregated.
For an aggregated field in an After Field layout, all records for which the corresponding field has
the same value (the sort group) are aggregated.

This table shows the available aggregation functions:

Function Description

Count The number of records. The print expression is unused for this function.
Total The sum of the grouped values. This value is reset for each group.
Cumulative The sum of the values across groups.

Minimum The minimum value within the group.

Maximum The maximum value within the group.

Average The average of the grouped values.

This option is available only if the data type of the domain is a numeric type.

Aggregation Condition

You can use this property to filter the records for which the value should be aggregated. If the
3GL expression evaluates to False, the value of the current record is not considered for the
aggregated value.
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This option is only available if an aggregation function is selected.

Calculate in layout

Optionally, select one or more layouts. The value is aggregated only if the selected layouts are
printed. If the session sends data to the report, but none of the selected layouts are printed, the
value remains equal.

This option is only available if the Aggregation function is set to Cumulative.

Reset after layout

Optionally, select one or more layouts. The value and suppression of the aggregate are reset if
the selected layouts are printed. This is useful if a single report contains multiple documents.
This option is only available if one or more layouts are selected for the Calculate in layout option.

Suppress after layout

Optionally, select one or more layouts. The printing of the aggregated value stops after any of the
selected layouts are printed.

This is useful if a total amount is printed in a layout that is displayed before the aggregate. This
situation occurs, for example, if the aggregate is in a footer layout.

This option is only available if one or more layouts are selected for the Calculate in layout option.

Suppression variable

Normally a variable name is automatically generated if one or more layouts are selected for the
Suppress after layout option. You can use this option to override that name with a specific variable
name. This variable is declared by the Report Designer and should not be an input field of the
report.

You can use this option to suppress other fields, or the entire layout, instead of only the aggregate.
This option is only available if one or more layouts are selected for the Suppress after layout
option.

Suppress Identical Values
If this check box is selected, a repeated value in this field is printed only once. Whenever the value
of the field changes, it is printed again.

Unless this field changes

Ignores the suppression of identical values whenever the selected field changes. Through this
property you can print the first value for each group, even if it is identical to the last value of the
previous group.

This option is only available if Suppress Identical Values is selected, and the report has sorted
input fields.

Formatting
You can format the field as bold, italic, and underlined.

Color
Specify the text color of the field contents.

Background
Specify the background color of the field. This fills the entire reserved space, regardless of the
length of the field contents.
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Font
Specify the font of the field. See the Fonts (ttaad3560m000) session. If not specified, the font
that is specified on the report is used. This value is displayed below the font property.

Font Size

Specify the font size of the field, in points. If not specified, the font size that is specified on the
report is used. If that value is specified, it is displayed below the property. If no value is specified
on the report, the PDF converter automatically resizes the text to fit the field. A calculation of that
size is displayed below the property.

Border
Specify which sides of the field should have a border and specify the border thickness, style, and
color.

Print condition
Specify the condition that must be met for the field to be printed. The expression is 3GL code.

Column

This property is relevant if you export the report to an Excel workbook.

Specify the Excel column on the current sheet where the field should be placed.

If you select multiple items, the specified value is applied to the first selected item. The value is
incremented for the other selected items. For example, you have selected four items and you
specify B in the Column property. For the first selected item, the value of the Column property is
B. For the other three items, the value of the Column property is C, D, and E respectively.

If you leave this property blank, the field is not included in the workbook.

Row

This property is relevant if you export the report to an Excel workbook.

Specify the Excel row number where the field should be placed. The value cannot be greater than
the value of the Rows property of the layout in which the field is present.

If you select multiple items, the specified row number is applied to all selected items. Therefore,
these items have the same row number.

For ‘non-exact positioned’ reports, the default value for this property is automatically set to the
layout line number within the layout. You can edit this value.

Adding a special field

Not all fields are input fields. The Special Items panel lists these non-input fields:

* Image

 Line

e Label

e Text

e Predefined Field
e Barcode

e Box

e Signature
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These special fields have a default size and no value set, when applicable.
To add a special field to the layout:

1 Drag the special field from the Special Items panel to the desired position in the layout.
2 Inthe Properties panel, specify the properties for the special field.

Alternatively, you can add a label or text with the description of an input field. To do so, drag the
icon next to the input field to the desired position in the layout.

Image
After adding an image to a layout, you must choose one of these types:

Company Logo
The logo for the current company is retrieved from the Companies (ttaad1100m000) session. If no
logo is defined for the current company, the logo of company 0 is used.

Static Image
You can upload an image file in the Report Designer. The image is stored on the LN server.

Image Field

The image field of a table is retrieved. You can upload these images in various LN sessions, such as
the Business Partners (tccom4500m000) session.

This option is only available if a report input field of the correct type is available.

Image Path

Specify a report input field that contains the path to the image file on the LN server.

You can create a report extension to add the report input field and set its value to the desired path of
the image. Optionally, the report extension can also retrieve the image from an external source, such
as IDM.

This option is available only if a report input field of the single-byte string type, with a length of at least
60 characters, is available.

When an image is specified, but its file cannot be found on the LN server, an error is reported when
printing.

These properties are available:

Left
Specify the position of the field from the left side of the layout.
This property is only available if the report uses exact positioning.

Top
Specify the position of the field from the top of the layout.
This property is only available if the report uses exact positioning.

Width

Specify the width of the field, in columns.

If the report uses exact positioning, this property is specified as a length.

The image is automatically re-sized to fill the field. This does not change the aspect ratio of the image.
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Height
Specify the height of the field, in lines.
If the report uses exact positioning, this property is specified as a length.

Alignment
Specify the horizontal and vertical alignment of the image within the field.

Column

This property is relevant if you export the report to an Excel workbook.

Specify the Excel column on the current sheet where the image should be placed.

If you select multiple items, the specified value is applied to the first selected item. The value is
incremented for the other selected items. For example, you have selected four items and you specify
B in the Column property. For the first selected item, the value of the Column property is B. For the
other three items, the value of the Column property is C, D, and E respectively.

If you leave this property blank, the image is not included in the workbook.

Row

This property is relevant if you export the report to an Excel workbook.

Specify the Excel row number where the image should be placed. The value cannot be greater than
the value of the Rows property of the layout in which the image is present.

If you select multiple items, the specified row number is applied to all selected items. Therefore, these
items have the same row number.

For ‘non-exact positioned’ reports, the default value for this property is automatically set to the layout
line number within the layout. You can edit this value.

Horizontal and vertical line

Both horizontal and vertical lines automatically expand their size to the maximum length that is possible
at the current position.

These properties are available:

Left
Specify the position of the line from the left side of the layout.
This property is only available if the report uses exact positioning.

Top
Specify the position of the line from the top of the layout.
This property is only available if the report uses exact positioning.

Width / Height
Specify the width or height of the line, in columns or lines.
If the report uses exact positioning, this property is specified as a length.

Left end / Right end
Specify the ending of a horizontal line, to connect corners to other lines.
This property is not available if the report uses exact positioning; lines can overlap instead.

Line thickness
Specify the thickness of the line as a length.
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This property is only available if the report uses exact positioning.

Line style
Specify the style of the line: solid, dashed or dotted.
This property is only available if the report uses exact positioning.

Color
Specify the color of the line.

Label

You can use labels for fixed text that is language-dependent. When printing, the reporting engine
automatically selects the best fitting label in the current language.

These properties are available:

Label

Specify the label code to be printed. The label must be present in the package of the report, or in the
extensibility package.

You can also search labels by description. After you specify a part of the description in the field, the
workbench shows a list of matching labels. If only one label matches the description, that label is
selected automatically.

Left
Specify the position of the field from the left side of the layout.
This property is only available if the report uses exact positioning.

Top
Specify the position of the field from the top of the layout.
This property is only available if the report uses exact positioning.

Width
Specify the reserved width of the field, in columns.
If the report uses exact positioning, this property is specified as a length.

Height

Specify the reserved height of the field. For multi-line labels, this must be a multiple of the number of
lines.

If the report uses exact positioning, this property is specified as a length, and there is no relation to
the number of lines.

Data length
Specify the maximum number of characters for the label description.

Label lines
Specify the maximum number of lines for the label description.

Align according to domain

If this check box is selected, the alignment of the label is linked to the alignment of the corresponding
field.

This check box is available only if the label code is a table field.
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Alignment

Specify the horizontal alignment of the label within its reserved space.

This option is not available if Align according to domain is selected.

If the report uses exact positioning, you can also specify vertical alignment.

Formatting
You can format the field as bold, italic, and underlined.

Color
Specify the text color of the label description.

Background
Specify the background color of the label. This fills the entire reserved space, regardless of the length
of the label description.

Font
Specify the font of the label. See the Fonts (ttaad3560m000) session. If not specified, the font that
is specified on the report is used. This value is displayed below the font property.

Font Size

Specify the font size of the label, in points. If not specified, the font size as specified on the report is

used. If that value is specified, it is displayed below the property. If no value is specified on the report,
the PDF converter automatically resizes the text to fit the field. A calculation of that size is displayed

below the property.

Border
Specify which sides of the label should have a border and specify the border thickness, style, and
color.

Print Condition
Specify the condition that must be met for the label to be printed. The expression is 3GL code.

Column

This property is relevant if you export the report to an Excel workbook.

Specify the Excel column on the current sheet where the label should be placed.

If you select multiple items, the specified value is applied to the first selected item. The value is
incremented for the other selected items. For example, you have selected four items and you specify
B in the Column property. For the first selected item, the value of the Column property is B. For the
other three items, the value of the Column property is C, D, and E respectively.

If you leave this property blank, the label is not included in the workbook.

Row

This property is relevant if you export the report to an Excel workbook.

Specify the Excel row number where the label should be placed. The value cannot be greater than
the value of the Rows property of the layout in which the label is present.

If you select multiple items, the specified row number is applied to all selected items. Therefore, these
items have the same row number.

For ‘non-exact positioned’ reports, the default value for this property is automatically set to the layout
line number within the layout. You can edit this value.
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Text

Use this special field to add fixed, language-independent, text to the report. It is commonly used for
single characters such as the plus sign or a colon.

These properties are available:

Text
Specify the text to be printed on the report.

Left
Specify the position of the field from the left side of the layout.
This property is only available if the report uses exact positioning.

Top
Specify the position of the field from the top of the layout.
This property is only available if the report uses exact positioning.

Width
Specify the reserved width for the field, in columns.
If the report uses exact positioning, this property is specified as a length.

Height
Specify the reserved height of the field, in lines.
If the report uses exact positioning, this property is specified as a length.

Alignment
Specify the horizontal alignment of the text within its reserved space.
If the report uses exact positioning, you can also specify vertical alignment.

Formatting
You can format the field as bold, italic, and underlined.

Color
Specify the text color of the text.

Background
Specify the background color of the field. This fills the entire reserved space.

Font
Specify the font face of the text. See the Fonts (ttaad3560m000) session. If not specified, the font
specified on the report is used. This value is displayed below the font property.

Font Size

Specify the font size of the text, in points. If not specified, the font size specified on the report is used.
If that value is specified, it is displayed below the property. If no value is specified on the report, the
PDF converter automatically resizes the text to fit the field. A calculation of that size is displayed below
the property.

Border
Specify which sides of the text should have a border and specify the border thickness, style, and color.
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Print Condition
Specify the condition that must be met for the text to be printed. The expression is 3GL code.

Predefined field

You can use several data fields on all reports, without having to define them as input fields. In the
Development Tools and LN Studio these are referred to as Specials.

These properties are available:

Special
Specify the type of predefined field to be printed.
This table shows the available types:

Predefined field type Description

Company Description The description of the company in which the report is printed, as defined
in the Companies (ttaad1100m000) session.

Company Number The number of the company in which the report is printed.

Date The current date on which the report is printed.

Time The current time on which the report is printed.

Number of Records The current number of records printed to the report.

Page The current page number.

Page Count The total number of pages. This option is only supported when printing
to PDF.

Report Description The description of the report.

Left

Specify the position of the field from the left side of the layout.
This property is only available if the report uses exact positioning.

Top
Specify the position of the field from the top of the layout.
This property is only available if the report uses exact positioning.

Width
Specify the reserved width for the field, in columns.
If the report uses exact positioning, this property is specified as a length instead.

Height
Specify the reserved height of the field, in lines.
If the report uses exact positioning, this property is specified as a length instead.

Data Length
Specify the maximum length of the field content.
You can modify this property only for Company Description and Report Description.
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Alignment
Specify the horizontal alignment of the text within its reserved space.
If the report uses exact positioning, you can also specify vertical alignment.

Formatting
You can format the field as bold, italic, and underlined.

Color
Specify the text color of the field.

Background
Specify the background color of the field. This fills the entire reserved space.

Font
Specify the font face of the field. See the Fonts (ttaad3560m000) session. If not specified, the font
specified on the report is used. This value is displayed below the font property.

Font Size

Specify the font size of the field, in points. If not specified, the font size specified on the report is used.
If that value is specified, it is displayed below the property. If no value is specified on the report, the
PDF converter automatically resizes the text to fit the field. A calculation of that size is displayed below
the property.

Border
Specify which sides of the field should have a border and specify the border thickness, style, and color.

Barcode

You can add a barcode to a layout, and then choose the appropriate barcode type. The contents of
the barcode depend on the type, and can be specified as a 3GL expression. The available properties
depend on the selected barcode.

These properties are generic:

Barcode Type
Specify the barcode symbology to use; both 1D and 2D barcodes are supported.

Data Expression
Specify the 3GL expression that evaluates to the data to print in the barcode. The permitted contents
depend on the selected barcode type.

Width

Specify the reserved width of the barcode, in columns. To preserve legibility of the barcode, the PDF
converter does not always scale or truncate barcode contents to fit the fields. Use the Show grid
during preview option to observe this behavior.

Height
Specify the reserved height of the barcode.

Print Condition
Specify the condition that must be met for the barcode to be printed. The expression is 3GL code.
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Column

This property is relevant if you export the report to an Excel workbook.

Specify the Excel column on the current sheet where the barcode should be placed.

If you select multiple items, the specified value is applied to the first selected item. The value is
incremented for the other selected items. For example, you have selected four items and you specify
B in the Column property. For the first selected item, the value of the Column property is B. For the
other three items, the value of the Column property is C, D, and E respectively.

If you leave this property blank, the barcode is not included in the workbook.

Row

This property is relevant if you export the report to an Excel workbook.

Specify the Excel row number where the barcode should be placed. The value cannot be greater than
the value of the Rows property of the layout in which the barcode is present.

If you select multiple items, the specified row number is applied to all selected items. Therefore, these
items have the same row number.

For ‘non-exact positioned’ reports, the default value for this property is automatically set to the layout
line number within the layout. You can edit this value.

Box

The box is a background item that does not contain any data. You can use a box to add a background
color on an area. The box can be positioned behind other fields.

These properties are available:

Left
Specify the position of the box from the left side of the layout. This property is only available if the
report uses exact positioning.

Top
Specify the position of the field from the top of the layout. This property is only available if the report
uses exact positioning.

Width
Specify the width of the box, in columns. If the report uses exact positioning, then this property is
specified as a length.

Height
Specify the height of the box, in lines. If the report uses exact positioning, then this property is specified
as a length.

Background
Specify the background color of the box.

Border
Specify which sides of the box should have a border and specify the border thickness, style, and color.
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Signature

You can use the signature to add a visual representation for a digital signature. The signature can be
a combination of an image and text. The printed document contains an empty field that is a placeholder
for the digital signature. When the document is signed using Document Output Management, the field
is filled.

These properties are available:

Left
Specify the position of the signature from the left side of the layout. This property is only available if
the report uses exact positioning.

Top
Specify the position of the signature from the top of the layout. This property is only available if the
report uses exact positioning.

Width
Specify the width of the signature, in columns. If the report uses exact positioning, then this property
is specified as a length.

Height
Specify the height of the signature, in lines. If the report uses exact positioning, then this property is
specified as a length.

Company Logo
The logo for the current company is used as image for the signature. The logo is retrieved from the
Companies (ttaad1100m000) session.

Static Image
You can upload an image file in the Report Designer. The image is stored on the LN server.

Image Path

Specify a report input field that contains the path to the image file on the LN server.

You can create a report extension to add the report input field and set its value to the desired path of
the image. Optionally, the report extension can also retrieve the image from an external source.

The image must still exist when the document is signed and the signature is filled in.

This option is available only if a report input field of the single-byte string type, with a length of at least
60 characters, is available.

Image Position
Specify the position of the image when both an image and text are used for the signature.

Vertical alignment of image
Specify the vertical alignment of the image if text is next to the image.

Text

Specify the text to show in the signature.

This table shows the variables that you can specify in the text; the variables are replaced when the
document is signed:
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Variable Description

#signer# The common name of the certificate that is used to sign the document.

#date# The date at the moment of signing.

#time# The time at the moment of signing.

#signature.textl# The content of the signature.textl variable as configured in the report
rule.

#signature.text2# The content of the signature.text2 variable as configured in the report
rule.

Horizontal alignment of text
Specify the horizontal alignment of the text within the signature.

Font
Specify the font of the text. See the Fonts (ttaad3560m000) session.

Font size
Specify the font size of the text in the signature, in points.

Color
Specify the text color for the signature.

Background
Specify the background color for the signature.

Adding a new report layout

1 Select an existing layout or a category in the Layouts panel.
2 Click the New icon on the toolbar in the Layouts panel.

The new layout is inserted after the selected layout. If a category was selected, the new layout
becomes the first layout in that category.

Sequence numbers in names of new report layouts

The name of a new report layout contains these two sequence numbers:

» The first number is the sequence number of the selected layout, or O if a category was selected.
* The second number is a sub-sequence number.

This does not mean that these layouts have a relation. They are completely independent and can also
be printed independently. The sequence numbers ensure the layouts are printed in the correct order,
and new layouts can be inserted even if there is no gap in the standard sequence numbers.
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For example: The standard report has layout “Detail 1” and “Detail 2”. If you select the first detail layout
and then add a new layout, “Detail 1 1" is created. You can print this layout if “Detail 1” is not printed,
and vice-versa. The layouts are always processed in that order. If the “Detail 1” layout is removed,
“Detail 1 1" is still processed before “Detail 2”.

If a Before Field or After Field layout is added, you must link these layouts to a sorted report input field.
If a new layout is inserted after an existing layout, the new layout is linked to the same field. When
adding a layout for a different field, you can select that field on the menu that is displayed when you
click the New icon.

Removing a report layout

1 Select the layout to remove.
2 Click the Delete icon on the toolbar in the Layouts panel.

This option is available only for layouts that were added in the personalization. Standard report
layouts cannot be removed.

Note: Removing a layout is permanent. After the Report Designer has been closed, you cannot recover
a layout that was removed. Therefore, do not remove layouts that you may require again later. Instead
of removing a layout, you can suppress it through the Print Condition property.

Applying conditional formatting

With conditional formatting you can change the formatting of fields based on data that is printed to the
report.

In conditional formats, you can define these properties:

e Foreground color
» Background color
 Bold

* ltalic

e Underline

* Border side

Top, Bottom, Left, Right, or combinations of these

* Border style
e Border thickness
 Border color

If the report is in exact positioning mode, you can also set horizontal alignment and vertical alignment
in a conditional format.

You can specify conditional formats for these report elements:
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* Report
* Layout
e Label
* Field

*  Special field

A single element can have multiple conditional formats. If multiple conditions evaluate to true, the
formats are merged. Conditional formats cannot be directly specified on all field types but a format on
a report or layout may also affect other field types.

Within a single element, properties are applied from top to bottom. For example, the first format of a
field specifies a blue background color. The second format specifies a red background color and white
foreground color. If both conditions are true, the field gets a blue background color and white foreground
color.

Across elements, properties override properties on a higher level. For example, a conditional format
on a layout specifies a red background color and white foreground color. A conditional format on a field
in that layout specifies a blue background color. If both conditions are true, the field gets a blue
background color and white foreground color.

Specifying conditional formats

1 Select areport, layout, or field. In the Properties panel, a Conditional Formatting link is displayed.
Click this link to open the dialog box where conditional formats can be configured.
Add or remove conditional formats in the grid.

Use the arrow buttons to rearrange the formats. The properties that are available on the format
have the same meaning as the properties on the fields. The condition is 3GL code.

A WN

Removing personalizations

To remove personalizations for the entire report, on the main toolbar, select Actions > Remove All
Personalizations.

This action is equivalent to removing the record in the Report Personalizations (ttadv9507m000)
session. The Report Designer replaces all layouts, fields, and properties with those of the standard
report.

To remove personalizations for a single layout, on the toolbar in the Layouts panel, select Actions >
Remove personalizations for the selected layout. The selected layout, including its fields and
properties, are replaced with the layout from the standard report.
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Copying or deploying personalizations

Initially, the report personalization is applied only for the user that created the personalization.

To copy report personalizations to other users or levels, use the Report Personalizations
(ttadv9507mO000) session. You can copy the personalization to another user, role, or company. When
the report is printed, the most specific personalization is used for the report. When the personalization
on a higher level is modified in the Report Designer, it is initially stored on user level again.

To copy personalizations to other systems, use these sessions:

» Export Configuration Data (ttaad7201m000)
* Import Configuration Data (ttaad7202m000)

Using multiple report personalization variants

Sometimes multiple designs are required for the same report. You can maintain such a personalization
through conditions on layouts or fields. If this becomes too complex, then you can use multiple variants
instead. You can use report personalization variants to create multiple personalizations on the same
personalization level. When printing a report for which multiple variants are applicable, the user can
manually select the variant to use.

Saving a new variant

You can use the Report Personalizations (ttadv9507m000) session to copy an existing personalization
to a new variant.

Alternatively, use this procedure to add a report personalization variant in the Report Designer:

1 Select Actions > Save as New Variant.
The Save Report Personalization as new variant (ttadv9207m000) session starts.

2 Specify the variant code.
3 Specify a label or a description.
4  Click OK to close the dialog and save the current personalization as a new variant.

The list of reports in the Layouts panel now shows a new entry for the same report, but with the
variant code you specified. You can modify and save the personalization in the same way as a
normal report personalization.

Infor LN Report Designer Development Guide | 37



Personalizing reports

Determining applicable report personalizations

To determine which report personalization variants are applicable, only the most specific level for which
a personalization exists is considered. The most specific level is user, role, or company, in that order.
If that level contains multiple variants, then a choice is displayed. Otherwise the only available
personalization is used.

This table shows examples of personalizations, all for the same report:

Level For Variant

Company 70

Role SERVICE Simplified Contract
Role SERVICE Complex Contract
User userl

If userl prints the report, then the one personalization on user level is used; the user does not have to
make a choice.

If user2 with role SERVICE prints the report, then the two variants on role level are applicable; the user
must make a choice.

Alternatively, the extension can make the choice instead of the user. To do so, the Get Alternative
Report hook of the report extension should set the spool . report.variant predefined variable to
the variant code to print. In this case, the most specific level for which the variant exists is used: if userl
prints the report, and the extension selects the “Simplified Contract” variant, then the personalization
on role level is used.

Troubleshooting in the Report Designer

If an error is displayed or the Report Designer shows strange behavior, it can be useful to create a
trace-file for support.

Start LN UL.

Select Options > Activate Trace Mode.

A window, which shows the LN Ul trace, is displayed. Close this window.

Start the Report Designer. A new trace window is displayed. Do not close this window.

After the issue has been reproduced, click Download Log File in the trace window.

If the issue cannot be reproduced, you can create a trace-file with less information. After the problem
occurs, press Shift + L in the Report Designer.

oo 01k WODN P

Caution: The trace-file that is generated by the workbench may contain sensitive information. The
reports that are printed while the Report Designer is open contain the report definition that is used
by the Report Designer. Therefore, these reports are logged in the trace-file. You should redact
sensitive information after downloading the trace-file. Replace this information with something obvious,
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such as a range of As or a range of zeros. The trace-file is a plain-text file and can be opened through
any text editor.
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Chapter 3: Generating new reports

1 Startthe Generated Reports (ttadv3548m000) session. An overview of the generated reports
and sessions is displayed.

2 Click New. The Select Current Activity (tlprj0140m000) session starts.

Generating new reports is done through activity-based development. Therefore, an activity must
be selected or created. These are the same activities as used by LN Studio and extensibility.

You must have developer authorization for the extensibility package, ‘tx’.

Note: Before you can select an activity, extensibility parameters must be present. See the Initialize
Extensibility (ttext0200m000) session and the Infor LN Extensions Development Guide .

3 Select an activity and click OK. The Report Designer is started with a different layout and the
Report Configuration dialog box is displayed.

4 Inthe Report Configuration dialog box, specify these properties:

Report code
The package and module code is “txgre”. This is read-only. Specify the rest of the report code.
By default, the first free sequence number is displayed.

Report description
Specify the description of the report, in the current language of the user.

Size
The size specifies the default margins and number of columns for the report. These sizes are
defined in the Default Sizes (ttadv3540m000) session.

Session description
Specify the description of the session, in the current language of the user.

Main table

Specify the first table to be selected by the generated session. The main table determines the
overall structure and grouping on the report. After selecting a main table, you can select referred
tables in both directions.

5 Click OK.
These panels are displayed:

Tables
The tree of references. The Refers-to folder contains tables with details of the selected table. The
Referred-by folder contains tables that refer to the selected table.
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For example: Sales Orders (tdsls400) refers to Sales Offices (tdsls012), which is one detail of the
sales order. Sales Orders (tdsls400) is referred by Sales Order Lines (tdsls401). The lines refer
to the order.

From refers-to tables you can browse further to other refers-to tables only. For referred-by tables,
both directions are available.

Next to the header of the panel, a breadcrumb from the main table to the selected table is displayed.
Click a table in the breadcrumb, to select that table.

Fields
The list of fields of the currently selected table. Array fields are displayed multiple times, once for
each element. The Selected column indicates whether a field is currently selected for the report.

Selected Fields

The overview of currently selected fields, with the same structure as the report has. The main
table is always present as a group. Fields of that table and refers-to tables are displayed in the
Fields list below the table.

If fields of a referred-by table are selected, a new group is created for that table, and the fields
are added to that group. In the same way, fields of refers-to tables of the sub-group are displayed
in that list.

For example, with Sales Orders as main table, all fields of the Sales Orders table and all fields of
refers-to tables of sales orders are displayed in the main group. If a field of Sales Order Lines is
selected, a new group is created. All fields of refers-to tables of sales order lines are displayed in
that new group.

Properties
This panel shows the session and report description and code. The properties of the currently
selected group are also displayed.

When you open an existing record in the Generated Reports (ttadv3548m000) session, this view is
directly displayed, without showing the Report Configuration dialog box. In that case, you can open
the Report Configuration dialog box by clicking Report Configuration on the main toolbar.

Adding or removing fields

You can add or remove fields to the current selection by toggling the Selected column in the Fields
panel. If the first field of a table is selected, a new group is added automatically. In the same way, if
the last field is de-selected, the group is removed automatically.

The selected fields indicate which fields are available on the report. If enough room is available, then
they are visible by default. Otherwise, they are added as report input field, but not placed on a layout.

Fields are added to the report in the order they are selected. In the Selected Fields panel, you can
move fields within a group, and groups within their parent group by dragging them to the desired
position.
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Changing group properties

After selecting a table in the Tables panel or the Selected Fields panel, the corresponding group is
displayed in the Properties panel.

Field Direction
Specify the direction of the fields on the report layout. Horizontal means the fields are in a grid below
their labels. Vertical means the fields are positioned in a list next to their labels.

Filter Present
The checkmark indicates whether a filter is specified for this group. The hyperlink starts the Report
Dataset Filter (ttadv9140m000) session, in which you can define a filter.

Filter Text
If a filter is present, you can specify a textual description of the filter in this field. The specified text is
displayed in the generated session.

Print group if no subgroups are printed
By default, a group is printed, even if no data is present or if all data is filtered out of the set. If this
check box is cleared, such a group is suppressed.

Applying a filter to a group

1 Click the Filter Present hyperlink in the Properties panel. The Report Dataset Filter
(ttadv9140mO000) session starts.

2 Add records with these properties:

Catenation Operator

Specify how this record should be combined with the other records. The first record is always an
“if”. Other records can be “and”, or “or”:

¢ “And” means the data must match both records.

* “Or” means the data must match one of the records to be printed.

The conditions are grouped automatically. Each “and” starts a new group, and each “or” becomes
part of the previous group. This grouping is indicated by the parentheses in the session.

Field Name
Specify the field on which to apply the filter.

Condition Operator
Specify the way in which to compare the specified value with the field value.

Input
If this check box is selected, the user can specify a value for the filter in the generated session.
Otherwise, the value is always applied implicitly, and not displayed in the session.

Value
The value with which to compare the field value. If Input is enabled, then this becomes the default
value that is displayed in the session, but the user can change it.
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Match Case
If this check box is selected, comparison of text fields is case-sensitive. Thus, for example, “field

content” is treated differently from “Field content”.

Generating the session and report

After selecting fields and optionally adding a filter, you can generate the session and report. You can
click Generate and run on the main toolbar to generate the session and report, and start the session
afterwards. In the generated session, you can print the report and test the filter. After closing the session,
the Report Designer does not switch to design mode. If no changes have been made since the last
time the report was generated, this button shows the text “Run” instead.

You can click Generate and design on the main toolbar to generate the session and report, and start
the session afterwards. In this case, if you print the report, after closing the session the Report Designer
switches to design mode for the generated report. You can style or position additional fields as
appropriate. In the design mode, a new button is available on the main toolbar to switch back to the
generation mode. If no changes have been made, this button shows the text “Design” instead.
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Chapter 4: Modifying generated reports

8

Start the Generated Reports (ttadv3548m000) session. An overview of the generated reports
and sessions is displayed.

If not a current activity is selected before, select Actions > Select Current Activity.
See Generating new reports on page 40.

Select the generated report. Select Actions > Check-Out.

Click Report Designer.

In Report Designer you can perform these actions:

¢ Add or remove fields.

« Change group properties.

« Apply afilter to a group.

* Generate the session and report.

For the applicable steps for each action, see Generating new reports on page 40.

Select Actions > Check-In.

Accept the default revision text or specify your own text and click Save changes and exit. Before
you checked in the generated report, the new generated report or the new version of the generated
report was only available for you. After check-in, the most recent version of the generated report

is available to all users who set their activity context to your activity.

Select Actions > Commit.

The new generated report, or the new version of the generated report, is available to all users.

Activity context

When starting the Generated Reports (ttadv3548m000) session, the activity context is automatically
set to your current activity. The activity context is changed when you select another current activity.

After the activity context is set, the sessions that are started run within this context. The sessions include
the functionality that is added in the generated reports.

With Options and Debug and Profile 4GL, you can also set activity context.

When the generated reports are committed, the sessions include the generated report functionality
without the requirement to set the activity context.
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Activity in title of session tab
This section is only applicable if LN runs on-premises.

Hint: To ensure your session runs in the correct activity context, add the activity to the title that is used
for the session tab in LN UI. To achieve this:

1 Select Options > Settings and select your current profile.

2 Add -set BAAN WIN TITLE="%S-%a tothe Command field in your User Profile Details. The
%a shows the activity context. The result is, for example, Item Defaults-actO001.
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Chapter 5: Exporting to Excel

You can export a personalized report to an Excel workbook.

Prerequisites
Before you can export the report to Excel, these prerequisites must be met:

* A '"Rewrite File" device that uses the exce1RD argument must be available.
See Creating an ExcelRD device on page 46.

* The report must contain personalizations.
» Excel Output properties must be specified in the report.

See Specifying Excel output properties on page 47.

Creating an ExcelRD device

1 Start the Device Data (ttaad3500m000) session and click New.
2 Specify this information:

Device

Specify the device code. For example, EXCEL_RD.

Description
Specify a description.

Device Type
Specify Rewrite file.

Locale
Leave blank.

Intermediate File in XML Format
Select this check box.

Driver
Leave blank.
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3

Shell Command
Leave blank.

4GL Program
Leave blank.

Argument
Specify excelRD.

Path
Specify the path to store the output file.

Change Output file allowed
Select this check box.

Page Length
Specify 0.

See the online help of the Device Data (ttaad3100s000) session.
Click Save.

Specifying Excel output properties

You must specify various Excel output properties in the report.

1

For the report as a whole, specify the Sheet Name property.
See Changing report properties on page 14.

For the layouts in the report, specify the Rows property.
For Before Field layouts, you must also specify the Sheet Break property.
See Changing layout properties on page 16.

For fields, images, labels, and barcodes, specify the Excel Output Column and Excel Output
Row properties.

Note: When printing to an EXCELRD device, only fields, images, labels, and barcodes for which
these properties are filled are included in the Excel workbook. A property is ‘filled’ if the property
is not blank and not equal to zero.

See these sections:

e Changing field properties on page 20

¢« Image on page 25

e Label on page 27

¢ Barcode on page 31

If you select multiple items, you can simultaneously specify property values for the selected items:

* If you specify a column, the specified value is applied to the first selected item, and is
incremented for the other selected items. For example, you have selected four items and you
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specify B in the Column property. For the first selected item, the value of the Column property
is B. For the other three items, the value of the Column property is C, D, and E respectively.

¢ If you specify a row number, that number is applied to all selected items, so that these items
have the same row number.

Exporting a personalized report to Excel

1 Start the print session to which the personalized report belongs.
2 Specify the desired options and select the ExcelRD device.
You can select this device on the File tab in the Select Device (ttstpsplopen) session.

3 Print the report to the ExcelRD device.

a Click Continue in the Select Device (ttstpsplopen) session. A Download File dialog box is
displayed.
b Click Download to store the generated spreadsheet on your computer.

Example

This screenshot shows an example of a Purchase Order report (tdpur4401m000), for which a few report
elements are exported to an Excel workbook:
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A green box refers to a report layout.

The blue text contains the Excel Output - Column and Excel Output - Row for the exported report
element. The Excel Output - Rows properties are decreased to avoid unnecessary empty lines, or
increased to provide enough space for the barcode.

Note: You cannot mix up elements between report layouts. For example, you cannot move a header
layout element to a detail or any other layout.
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